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Grow With Computer-1

Exercise

Based on NEP 2020
1. Tick ( v ) the correct optlon
Ans. a. ii b. ii.
2. Fillin the blanks :
Ans. 1. Machines are run by man.

2.  Machines are tools that make our work easier .

3. Acomputerisa electronic machine.

4. Computer can be used to add numbers and play games .
3. Write True or false :

Ans. a.True b.True c.False d. False
4. Fillin the missing letter :
a. MOUSE b. FAN
c. ENGINE d. COMPUTER
5. Match the following :
Ans. 1. Cycle a Ironing clothes
2. Iron b. grinding
3. Televisio c. transport
4. Pen d entertainment
5. Mixie e writing
Exercise Based on NEP 2020
1. How is a computer different from you? Write Yes or No
against these questions in the boxes :
Ans. a. Canyoumove? Yes
Can a computer move? No
b. Canyouremember things? Yes
Can a computer remember things? Yes
c. Canyoudosums very quickly? No
Can a computer do sums very quickly? Yes
2. Name the five parts of the computer given below :
Ans.

Monitor

Speakersj

Keyboard_ & Mouse

3. Tick (v') the correct option :
Ans. a.iv. b.1ii. c.i.

4. Write True or False :

b. False

c. True d. False.

Ans. a.True

Exercise
1. Write the full forms of :
Ans. CPU Central Processing Unit

Based on NEP 2020

A Smart Machine-Computer l.' ‘f!‘-’l'

6. Identify these machines and state the work they do :
Ans.

Toaster Mobile Phone Calculator

Tape-recorder

Monitor

Miocrowave

Activity & Project Tasks
Ans. Do yourself.

The Computer And Its Parts & 'f.‘- v

5. Fillin the blanks :
Ans. a. Acomputerneeds electricity to operate.

b. Letters, numbers and some special symbols on the
keyboard are called keys.

c. CPU helps the computer to remember, think and do
things.

d.  Mouse helps you to draw pictures and play games.

6. Answer the followmg questions :
Ans. a. Acomputerisamachine. It makes our work easier.

b. Monitor, CPU, Cabinet, Mouse, Keyboard, are the
main parts of a computer.

c. A computer mouse makes us to reach anywhere on the
screen with the help of its pointer. It helps us to draw
pictures and play games.

d. Thefour qualities of a Computer are:

1. Itworks on electrcity.
2. TItworksvery fast.
3. Itmakes our work easy.
4. Itnever makes mistakes.
Activity & Project Tasks
Ans. Do yourself.

Helping Parts Of A Computer : 'f.‘- w

UPS : Uninterrupted Power Supply
VDU Visual Display Unit
CDh : CompactDisk.
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Ans.

Ans.

Ans.

Tick (v') the correct option :

a.il. b.iv. c.i.

Fillin the blanks :

a. Printer prints the text on the paper.

b. UPS helps the computer even when the electricity goes
off.

c.  Wecan listen to music with speakers.

d. Joystick help us to play games.

Answer the following questions :

a. The printed paper that comes out of a printer is called
printout.

b. Ascanner helpsus to scan pictures, images and text.

c.  Wecansee our friends online using a web camera.

d. Hard disk, CD, DVD, Pen drive are some common
storage devices of acomputer.

Activity & Project Tasks

Ans.

Ans.

Ans.

Do yourself.

Exercise Based on NEP 2020
Tick (v') the correct option :
a.iv. b. iii. c.i.
Fillin the blanks :

a. Wecanplay games on a computer.
b. Wecan listen to music on a computer.
c.  Wecan store information on a computer.
d.  We canmake drawings on a computer.
e. Acomputer is useful machine.
f.  Acomputerisalsoused tosend and receive message.
Answer the following questlons
a. Acomputer helps us in many ways :
1. We can write letters and send messages to our
friends and relatives through a computer.
2. We can learn many new things with the help of
computer.

Exercise Based on NEP 2020

Here are the steps to turn ON the computer. Number the
instructions in the proper order.

.« Switch ON the main power supply.

«  Switch ON the UPS

. Switch ON the CPU

«  Switch ON the monitor

«  The Desktop Screen appears
Number the steps in proper order to turn the computer
OFF.

. Click on Start

«  Clickon Turn OFF

«  Switch OFF the monitor

. Switch OFF the CPU

. Switch OFF the UPS

. Switch OFF the main power supply

Uses Of A Computer A' ‘f:’l'

3. Acomputer helps us to draw pictures.
b. Computers are used in banks, hospitals, shops, offices,
malls, sports, airports, railway stations etc.

Activity & Project Tasks

Ans.

Ans.

Do yourself.

Operating A Computer & ¥ l.'

Tick (v') the correct option :

a.iv. b.iv. c.iil.

Rearrange the following jumbled letters to get some
words from the lesson :

a. NOUTRN TURN ON

b. FOFUTNR TURN OFF

c. DNWOUSHT SHUT DOWN

d. PPSULY WPOER POWER SUPPLY

e. ESDKTPO DESKTOP

Fillin the blanks :

a. Desktop is the first screen after booting.

b. Insertand ejectare opposite to each other.

c. Acomputerneeds electricity do work.

d. UPS supplies power to computer when electricity goes

off.
e. Pressthe Open button toinserta CD in CD drive.

: ' Grow With Computer—l '-'



f.  "Turn OFF' option is present in Start button.
6. Answer the following questions :
Ans. a. ThestepstoinsertaCD inthe CDdrive:
1.  Wepressthe ' OPEN'button gently.
2. The CD tray comes out. Place CD onit.
3. Again, press the same button.
b. ThestepstoejectaCD fromaCDdrive:
1. We press the 'OPEN' button on the CD drive
gently.
The CD tray comes out. Take out the CD fromiit.
Again, press the same button. The tray goes inside

Exercise Based on NEP 2020
1. Do yourself.
2 Write the number of :

Ans. a.

Letter keys on the keyboard. 26
b. Numberkeys on the keyboard. 20
c. Enterkeys onthe keyboard. 2
d. Spacebar on the keyboard. 1
3. Answer in one word :
Ans. a. Rectangulardevice with many small buttons. Keyboard
b. Another name for buttons. Keys
c. Itisusedtomove to the nextline. Enter key
d. [Itisusedto delete the letters. Delete key
4. Tick (v') the correct option :
Ans. a.iii. b.ii. c.iv.
5. Write True or False :
Ans. a.False b. False c.True d. True
Exercise Based on NEP 2020
kns' Write the names of the parts of a mouse. Right button
Left button
Scroller
Wire
2. In the mouse shown alongside, which BIFBR!

button will you press for left-click? Which
for right-click? Mark with 'L' and 'R".

3. Tick (v') the correct option :

a.iv. b.ii.

4. Fillin the blanks :

Ans. a. Amouseisacomputer part with the long tail like wire.
b. A mouse helpsus to point the things on a computer.
c. Pressing the mouse button twice is called double

clicking.
5. Write True or False :
Ans. a.True b. True c. False.
6. Rearrange the following jumbled letters to get some
words :
Ans. a. OSUEM MOUSE

back.
c. A UPS is attached to a computer, so that a computer
does not switch OFF at once when the power goes OFF.

Activity & Project Tasks

Ans.

Ans.

Ans.

Do yourself.

Getting Familiar With A Keyboard/Keyboarding { - .‘-’f

e. True f. True.
Answer the following questions :
a. A keyboard is a rectangular device with many small
buttons on it. These buttons are called keys.
The buttons on a keyboard are called keys.
Akeyboard is used to enter commands into a computer.
d. Akeyboard has different sets of keys marked on it.
. Alphabetkeys . Numberkeys
. Functionkeys . Arrowkeys
. Spacebarkey . Enterkeys

oo

Getting Familiar With A Mouse : "f.‘-f

b. ONERTIP POINTER

c. USRORC CURSOR

d. COLRELRS SCROLLER

e. LCIGNKIC CLICKING

f. RGIGNGAD DRAGGING

g. OMNSDAMC COMMANDS

h. LNTASROWRA SLANTARROW

Answer the following questions :

a. A mouse is a small object that can roll along a hard flat
surface. Itlooks like a mouse.

b. Mouseisused to move the things on a computer screen.

Itis used to play games on a computer.

c. The slant arrow, with a left slant on the screen is the
mouse pointer or cursor.

d. Dragging is moving the mouse with keeping the left
mouse button pressed.

Activity & Project Tasks

Ans.

Do yourself.
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Exercise Based on NEP 2020

1. Look at the pictures given below. Write the name of the
tools used to draw different parts of this picture. Choose

fr0.m these words.
Ellipse tool

Ans.

Ellipse tool

2. Match the tools that to their names.

Ans. % ?‘i |:| \ A

Ellipse tool

Texttool Linetool Brushtool Airbrushtool Rectangle tool
. Number the steps to open a Paint in the correct order.
Ans. . Click onthe Start button on the desktop screen

. GotoPrograms

. GotoAccessories

Exercise Based on NEP 2020
1. Tick (V') the correct optin :
Ans. a.iii. b.i. c.ii

2 Fillin the blanks :

a The screen where all the icons are arranged is called a
desktop .

b. Icons of activities that we use often are kept on the
Desktop .

¢ Thebarat the bottom of the screen is called task bar .

3 Write the True or False :

a.False b.True c.True

4. Match the following :

Ans. a. RPAEPLWA 1. DESKTOP
b. HSFINI ii. WALLPAPER
c. EDKSOTP. iii. TASKBAR
d. RBASATK- iv. WINDOWS
e. IWNSWOD V. FINISH

Fun With MS Paint £ ™ &

.  Click on Paint
4. Fillin the blanks :

Ans. a. Thepenciltool helps youto draw free-hand drawing.
b. Youcanselectdifferent colours from the colour box.
c. Theeraser tool helps you to erase drawings.
d. The white portion of the paint screen is called the
drawing area.
5. Answer the following questions :
Ans. a. Paintisaprogram which we canuse for drawing.
b. Toolbox helpsus to draw.
c. Colour Box helps us to colour our drawing.
d. Tosavethe work, do the steps given below :
. ClickonFile.
. Clickon'Save As' option.
. The'Save As'dialog box appears.
. Typethe filename.
. ClickonSave.
Activity & Project Tasks
Ans. Do yourself.
: By B
Exploring The Desktop g ¥ &Y
5. Fill in the missing letters :
Ans. a. WALLPAPER b. DESKTOP
c. TASKBAR d. SCREEN
Activity & Project Tasks
Ans. Do yourself.
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Grow With Computer-2

Exercise Based on NEP 2020
1. Unscramble the following to find meaningful words :
Ans. a.LAPTOP b.TABLETPC
¢. TASKTOP d.NOTEBOOK

2. Tick (v ) the correct option :

"af
3. Fillin the blanks :
Ans. a. Wecanplay games on a computer.

b. Wecanwatch cartoon on a computer.

c. Atable PCisaslate-shaped mobile compter.
d. Alaptopisalso known as anotebook computer.

BN

=

Exercise Based on NEP 2020
1. Name the different types of computers given below :

g -
Desktop Palmtop Laptop
2. Tick (v') the correct option :
Ans. a.i. b. ii. c. iii. d.i.
3. Rearrange the following jumbled letters to get proper
words :
Ans. a. OSPERNAL PERSONAL
b. TEDSKOP DESKTOP
c. NHADEHLD HAND-HELD
d. TALPOP LAPTOP
e. OHASMRTPNES SMART PHONES
f. OOLG LOGO
4. Write True or False :
Ans. a.False b. False c. True d. True e. True.

5. Answer the following questions :
Ans. a. Computers are of different types and sizes. They are

Know Your Computer £ ¥ & ™

4. Write True or False :

Ans. a.False b. False
Activity & Project Task:
Ans. Doyourself.

c. True d. True

More About Computer & aras

classifiedas:

1. Desktop Personal Computer (PC)
2. Laptop computer

3. Hand-held computer

b. We can add games and other applications to these smart
phones like we do on a computer.

c. A computer language is used to communicate with a
computer. There are various computer languages being
used to make computers work according to our
instructions. Some of them are LOGO, QBASIC,
HTML, C++and Java.

d. A computer program is the set of commands given to a
computer with the help ofa computer language.

Activity & Project Tasks
Ans. Doyourself.
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Uses of Computer : - f’f

Exercise Based on NEP 2020 3. Toenjoy music and movies.
1. Tick (v') the correct option : 4. Tokeeprecords.
Ans. a.iv. b. iii. c. iil. d.iv. e. iil. d. Computers are useful in schools in the following
2. Write True or False : manner:
Ans. a.True  b.False c. True d. True e. True. 1. Inschooloffice.
3. Fillin the blanks : 2. Enjoying multimedia.
Ans. a. Computerisaveryuseful machine. 3. Learninginclassroom.
b. Computers help us to enjoy music and movies. 4. Maintaining records in library.
c. At offices, computers are used to store information  Activity & Project Tasks
and data. . Paste pictures of two places where you see the use of
d. Computers, also help us to keep records of patients in computers.
hospitals. Ans. Do yourself.
e. Computer helpsus to draw money from an ATM. . Collect atleast five computers bills and paste them in
4. Answer the following questions : your project file.
Ans. a. Thethreeusesofacomputerare: Ans. Do yourself.

1. Todohomework.
2. Towrite letters and reportin office.
3. Tokeeprecords of transaction in banks.
b. Thetwouses of computer in banks are :
1. Keepingrecords of transactions.
2. Drawing money from ATM.
c. Computers are useful to us at home in the following
manners :
1. Todohomework.
2. Toplay games.

Computer Devices f - .‘-f

Exercise Based on NEP 2020 devices.
1. Tick the correct answer from the choices given for each b. Theresultproduced by a printer is called hard copy.
device: c. Computer processes the result through CPU.
Ans. a. InputDevice b. InputDevice d. Harddisk, CDs are the examples of storage unit.
c. Output Device d.  Output Device e. Keyboardisaninputdevice.
e. InputDevice 6. Match the following :
2. Tick (v') the correct option : Ans. .  Monitor . showsmewhatIdo
Ans. a.iv. b.ii. c. iii. d.iii. . Mouse . youcandraw pictures with it
3. You want to do these jobs. Name which parts will be . Scanner . works like a photocopier machine
useful to you : . Printer . prints my drawings
Ans. a. Writingapoem. Keyboard 7. Answer the following in one word :
b. Printing a greeting card. Printer Ans. a. Keyboard b. Joystick
c. Playingacomputer game. Joystick c. CPU d. Monitor
d. Listening to songs on the computer. Speakers e. Harddisk f.  Pen-drive
e. Showingadrawing to his computer teacher. Monitor 8. Answer the following questions :
4 Match the pictures with their names: - Ans. a. Each particular part of acomputer is called a device.

Ans. b.  Acomputer has four main types of devices :
1. Inputdevices 2.Processing device
3. Outputdevices 4. Storage devices

c. The computer parts which help us to give instructions
to the computer are called input devices. Examples of
input devices are the keyboard, mouse, joystick,

-

scanner, web camera etc.
d. The parts of the computer that give us result (output) are
called output devices. Some examples of output
5. Fillin the blanks : devices are monitor, printer, speakers etc.
Ans. a. Computer takes the data/orders through its input e. The parts in the computer that store our computer work

: ' Grow With Computer-2
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are storage devices.
Activity & Project Tasks

Ans.

Do yourself.

Exercise Based on NEP 2020
Tick (v') the correct options for the following actions :

a. Verybad b. Good c. Verybad

d.  Verybad e. Good f.  Good

g. Verybad h. Verybad.

Tick (v') the correct option :

a. iil. b.ii. c.ii. d.iii.

Write True or False :

a.False b.False c.False  d.True e. True

Fillin the blanks :

a. In school computer-lab, you must take off your shoes
before entering.

b. Keep the computer neatand clean.
c. Coverthe computer with cloth when not is use.
d.  Weshould not pull the wires of the computer.
e. Donotputfingers in the slots meant for cables.
f.  Donotcrowd near the computer.
g. Keepproper distance from the monitor.
Match the two columns :

A B
. Sit . Straight

Exercise Based on NEP 2020
Read the given clues and make four words using the
letters in the first and second row of alphabet keys.

a. DOG b. DELHI

c. WHITE d. APPLE

Tick (v') the correct option :

a.li. b.iv. C.1. d. 1ii. e.l.

Write True or False :

a. False b. True c. True d. False e. False.
Fillin the blanks :

a. Keyboardisused to enter data into computer.
Special keys are used to perform special functions.
Arrow keys are also known as cursor control keys.
Spacebar is the longest key.
Function keys are used in combination with other keys.
Num lock key is used to use the numeric keypad.
Number keys are present at two places on keyboard.
swer in one word :
Alphabetkeys
Caps Lock
e. Enter
g. Arrow
Answer the following questions :
a. Akeyboard is an input device of the computer. It sends
the data to computer by typing.
b. Alphabet, Number and Special keys are the main types
ofkeys in the keyboard.
c. The small blinking line on the screen which shows our
position on the screen is a cursor. »

Number keys
Backspace
Spacebar
Delete

b

C

d

e

f.
g.
An
a.
c.

Frac

Ans.

Do's and Don'ts with Computer : -
. Remove . Shoes
. Computer room door . Keepitshut
. Donotpull . Wires
. Blink . Eyes

Answer the following questions :

a. We should not touch the power cords of the computer
because we can get an electrtic shock by doing so.

b. [Igiveproper space to my friends and take turns in using
computers.

c. Ikeep my computer clean by cleaning it with soft dry
cloth. I do not eat or drink near the computer and cover
the computer not in use.

d. Thetwo things we should do in our computer lab are :

1. Weshould share computer with our friends.
2. We should not push or pull our classmates while
using computers.

e. Now, we should not hit hard on the keys of the
keyboard.

Activity & Project Tasks

Ans.

Do yourself.

Working with Keyboard : -

d. Arrow keys help us to move in all four directions on the
screen.

e. Numeric keypad is situated at two places on the
keyboard. It is used for typing numbers containing
digits 0-9.

Activity & Project Tasks

1. With the help of your teacher, type the lines as shown.
Ans. Do yourself.
2. Fill in the crossword with the help of picture clues. (One
is done for you.) C |
Ans.
U

a R

A S

L 0
B s » A cce8 AR

H

A

3 NUMBER
ENTER
T

A ' Grow With Computer-2
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Exercise Based on NEP 2020

1. Circle the tasks we can do with the help of a computer
mouse :

Ans. 7.
Listening to music Jumping Ans.
Typing letters Calculations

Can type

2. Write the mouse action for each picture :

Ans. a. Single-click b. Double-click
c. Draggingand Dropping d. Right-click

3. Tick (v') the correct option : 8.

Ans. a.il. b.iv. c.iv. d.ii. Ans.

4. Write True or False :

Ans. a.True b. False c. False d. True
e. True f. False.

5. Fillin the blanks :

Ans. a. Amechanical mouse hasaballinside it.
b. The mouse pad is the mouse's home.
c. Anoptical mouse uses light instead of a ball.
d. Doubleclickisused to open an item.
e. Scrollmouse can be of two types.
f.  The position of mouse on computer screen is called
pointer.
6. Match the following :
Ans. . Leftclick . Selecting theicon Ans.
. Doubleclick . Openingaprogram
«  Scroll Wheel . Tomoveupanddowninapage

Exercise Based on NEP 2020

1. Fillin the blanks :

Ans. a. Data arranged in a planned manner is called
information .
b. The firdt step of giving information to a computer is
input.
c. The second step in the working of a computer is
processing .

. Output can be in the form of words or picture .
e. Output means to put-out.
2. Match the following :

Ans. a. Data output
b. Processing three
c. Result enter data
d. Stages CPU
e. Keyboard input
3. Fillin the blanks :
Ans. a.False b.True c.True d.False e.False.
4. Answer the following questions :
Ans. a. When data is arranged in a planned way, it is known as
information .

b. Dataorinformationis called' INPUT'. This input can be
in the form of numbers, words or pictures.

-

A ' Grow With Computer-2

Working with Mouse : ‘f: w

. Rightclick . Shortcut menu

. Dragging . To move the mouse while
holding the left button pressed

Answer in one word.

a. Mouse should always be kept on : Mouse pad

b. Pressing of mouse button once is called : Clicking

c. Pressing of mouse button and moving cursor on screen is
called: Selecting

d. Pressing of mouse button twice is called : double-click

e. Mouse pad prevents mouse from : dust

Answer the following questions :

a. Mouse is also called a pointing device. It is used to point
and select items on the computer screen. It is also used
while playing games and making drawing.

b. Mouse is called an input device because it gives input to
the computer.

¢. A mouse has mainly four parts—left button, scroll wheel,
right button and a wire.

d. Single-click, double-click, drag and drop, selection and
right click are all the actions of a mouse.

e. Dragging the mouse means to move the mouse while
holding the left button pressed. Releasing the mouse
button after dragging is called dropping.

Activity & Project Tasks

Do yourself.

Working Manner of Computer { ‘f: v

c. Processing means arranging the data to get useful
results.
d. Outputistheresult given on the monitor .

Activity & Project Tasks
Ans.

, 1
P N “p
R P A

"OUTPUT
CT A
B
S
S




Ans.

Ans.

Ans.

Ans.

Exercise
Identify the following tools :

B £
Brush Airbrush

@] 5

Magnifier Polygon
Tick (v') the correct option :
a.l. b.1iv. c. 1il.
Fillin the blanks :

Paint program used for drawing pictures.

Tools can be selected from Toolbox.

Line tool can be used to draw lines.

The Menu bar contains the various menu titles.

You can select colour from the colour box.

The Fill with Color tool fills the object with colour.
nswer in one word :

Paint

Toolbox

Based on NEP 2020

™
Line
f

Eraser

(I
Rectangle

2

Pick color

b. Drawing
d. Colourbox

a.
b.
c.
d.
e.
f.

A
a.
c.

Exercise Based on NEP 2020
Tick (v') the correct option :
.oa.di. b.iv. c.ii. d.iv. e.il.
Write True or False :
. a.True b. False c.False d. True e. True.
Fillin the blanks :
a. The full form of LOGO is Language of Graphic
Oriented.

b. Turtleis triangular in shape.

¢. Toinstruct LOGO, youneed to give commands.

d. Debugging is the process of correcting the mistakes
from the program.

e. LOGO commands are given in Input box.

Answer the followmg questions :

a. LOGO is a simplest computer language. It stands for
Language of Graphic Oriented.

b. Commander Window consists of all the tools we need
to give commands to the turtle, in order to complete the
desired task. It has many parts like :

1. Command list box 2. Input box 3. Command buttons.

c.  LOGO has many features and can do lots of work for us,
itisusedto:

(1) draw pictures : simple shapes and patterns
(2) write : writing text

(3) docalculations

(4) perform simple logical operations.

d. Debugging is the process of correcting the mistakes
from the program.

e. Command buttons are used for performing special
tasks. Reset, Halt, Trace, Pause, Status, Step, Execute,
etc., are some command buttons.

MS-Paint £ ¥ &>

5. Answer the following questions :
Ans. a. MS-Paint program is used for making beautiful
drawings on a computer.

b. Thesteps to open the MS-Paint program are :
1. Click on the Start button.
2. Pointto Programs.

3. PointtoAccessories. 4.  Click on Paint.
c. Themain parts of Paintscreen are :
1. Menubar. 2. Drawing Area.
3. Toolbox. 4. Colour box.
Activity & Project Tasks
Ans. Do yourself.

Let's learn LOGO A’ "f .‘- w

Reset command button is used to clear the LOGO
output screen. Halt button immediately stops LOGO
from processing further.

Activity & Project Tasks

Name the various parts in the given LOGO screen.

Ans.

;Title bar ;Menu bar

&

/T11rtle

Main output screen

Conllnallder
W1 l‘l(‘lOW

AN |

Command
buttons

COll‘l mand

Input box
list box
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1.

Ans.

Ans.

1.

Ans.

Ans.

\3.

Ans.

4.

Ans.

~\
@
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Exercise Based on NEP 2020

Answer the following questions :

a.

The major technological advancement that changed the
way of computer operations, define a generation.

There are 5 generations of computer

Vaccum Tubes

The Transitors helped computers to become fasters,
reliable, smaller and cheaper than their predecessors. It
marked a new beginining in the developement of
modern computers.

ICs are small chips. It marked a breakthrough in
advancement of computers. A huge number of
transistors could be accommodated into a small chip of
an IC. Computer became more compact, cost came
down and became more efficient .

Artificial Intelligence ( Al ),the science which is
concerned with making computers behave like
humans.

With the invention of the micro processor, the fourth
generation of computers was born. With this, thousands
of 1Cs could be packed onto a small chip .

Fillin the blanks :

a.

b.

The Computers were huge, slow and expensive .
ENIAC was the first electeonic, digital computer .

Exercise Based on NEP 2020

Following are some places where computers can be used.
Match the names with the pictures.

a. Hospital

b.Railway c.School d.Bank e.Library

School

Hospital
Tick (v') the correct option :
a.iv. b. iii. c.i.
Fillin the blanks :
a. Acomputer is auseful machine.
b. Librarianuses the computer to search the book to you.
c. Computerisused to book tickets at railway stations.
d. Computer cannot play in grounds.
e. Youcan listen to music on a computer.

Answer the following questions :

a.

A computer is a useful machine. It can do many things.
We can play games, listen to music, and watch movies

e.
f.

History of Computer

It marked a new beginning in the development of
modern computers .

A huge number of transistors could accomodated into
asmall chipofanIC.

The Intel 4004 chip, developed in 1971.

In 1981, IBM introduced the personal computer for
home and office use.

Activity & Project Tasks

Ans.

Do yourself.

Uses of Computers

on acomputer.

(i) Library : The librarian uses a computer to store a list

of books and their location. When we you want to

borrow a book, the librarian check the computer to see

ifitisavailable.

(ii) Bank : The bank uses a computer to store a list of

people and their accounts.

(iii) Railway Station : Railways use computers to book

tickets. Computers are also used to maintain train

timings.

A computer is very useful to children. The four uses of

computer for children are :

1. The children can complete their home work using
acomputer.

2. They candraw apicture.

3. They can watch cartoons and movies.

4. They can listen to music.

Activity & Project Tasks

Ans.

Do yourself.

: ? Grow With Computer-} "' T'



Introduction To MS Windows 7 & ‘f:’l'

Exercise Based on NEP 2020 . Programs are arranged in different folders and
1. Tick (v') the correct option : files.
Ans. a.il. b.i. c.iil. d.i. . It has icons which help to do different tasks
2. Write True and False : quickly.
Ans. a.False b. True c. True d. False e. True. d. Gadgets are mini programs that provide information at
3. Fillin the blanks : a glance and easy access to frequently used tools. For
Ans. a. Windows 7 is one of the latest versions of Microsoft example, a game, picture, slide show, free headliner,
Windows. clock or calendar.
b. MS Windows has many flavours called versions. e. An icon is a small picture that is used to open the
c. Desktop background, icons, taskbar and gadgets are program, file or folder.
the four main components of Windows 7 desktop. Activity & Project Tasks
d. Iconmsare the small pictures present on the desktop. Ans. Do yourself.

e. The taskbar has a Start button, Quick launch bar,

System tray and Show desktop button.

4. Answer the following questions :

Ans. a. Operating system is a software that helps us to operate
the computer system through its various functions.

b. When we switch ON the computer, the operating
system gets loaded into the computer's memory. This
process is called booting.

c. Most of the people use MS Windows as an operating
system in their computers because :

. Itisveryeasytouse.

. Itisagraphic based (GUI) operating system, so we
do not have to remember all the commands, as in
some other operating system.

Activities using a Mouse : - .‘- w
Exercise Based on NEP 2020 3. Release the mouse button when the mouse pointer
1. Tick (v') the correct option : is on the folder. This action of the mouse is called
Ans. a.ii. b. ii. c.i. 'Drop'.
2. Write True or False : d. Reorganizingiconsonadesktop:
Ans. a.True b. True c.False d. True e. False 1. Selecttheicon (using left click of the mouse).
3. Fillin the blanks : 2. Dragtheicon onthe desktop using the mouse.
Ans. a. Filesarcusedtosavesongs, pictures, text files, etc. 3. Release the mouse at an empty space, to drop the
b. Filescanbeorganised and saved in different folders. icon at that place.
c. Wecanuse mouse to create a folder. e. Tochange the position of the taskbar, we can follow the
d.  Youcan move the objects on the desktop. given steps :
e. Youcanalsochange the position of the taskbar. Step 1 : Right-click on the taskbar and uncheck the
4. Answer the following questlons 'Lock the taskbar' option by clicking onit.
Ans. a. Afolderhelpsusto organize files on a computer. Step 2 : Now, drag the taskbar to any side of the screen
b. Tocreateafolder: to change its position.
1. Move the mouse pointer to any empty space on the 5. What happens when :
desktop. Ans. a. Whenwe double click on a file or folder icon, the file or
2. Right click (click once on the right button of the folder opens immediately.
mouse). b. When we click the left mouse button on the icon file, the
3. Selectthe option 'Create Folder'. fileis selected.
4. Enteraname for the folder. Activity & Project Tasks
c. Thestepstomove the files into a folder are : Ans. Do yourself.

1. Selectthe file (using left click of the mouse).

2. Hold the left button pressed and move the mouse
towards the folder. The file icon selected also
moves as we move the mouse pointer. This is
called 'Drag'.
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1.
Ans.
2.
Ans.

3.
Ans.

4.
Ans.

5.
Ans.

Exercise
Tick (v') the correct option :
a.ii. b. iii. c. iil.
Fillin the blanks :
a. Acassette player plays song that are stored on the CD.
b. Thesongs are stored as music files on the computer.
c. Thesongs stopped as you click on the Pause button.
d. Slider can be usedto increase or decrease the volume.
Match the music player buttons with its use :

Play

Open
E Pause
]

What happens when?

a. When we pause a song and then press play, it will
continue playing from where it had stopped.

b. When we move the mouse pointer over the buttons, it
will show the name of the buttons.

Answer the following questions :

a. We can decrease or increase the volume by moving the

slider left or right.

Rewind and Forward buttons are used to jump to a

different part of the song or a different song.

Mute button turns OFF the volume when it is pressed.

The song continues to play, but we cannot hear it.

Based on NEP 2020
Label
Ans.

Previous

Previous
Stop

b.

Exercise
Tick (v') the correct option :
a.i. b.iv. c.1. d.iv. e.ii.
Write the names of the following tools of wordpad.

¥ Boldbutton

Based on NEP 2020

6.
Ans.
7.

Ans.

s ~ Fontbox

a

Italic button Fontsize

U  Underline button

Colour the correct option in green.

Alignment

8

New button .
Ans.

Save button

. Doyourself.

Circle the correct word from the brackets to complete
the following

statements :
(Tool box) has different buttons on it, which

a.
helps you in making nice document.

b. Bold, underline and highlight) functions are
used for highlighting the text.

c. Textstyle canbe changed rising (style name
tool in the toolbar.

d. Wordpadcan be closed using (close) option.

Name the keys :

a. Enterkey b. PageUpkey

c. Backspacekey d. Deletekey

e. Spacebarkey f.  CapsLockkey

»

A ' Grow With Computer-3

Song progress

Using a Music Player f‘fl‘-’f

Activity & Project Tasks

the control buttons in the given picture :

Song title

Panning bar

. Py By
Working In Wordpad g ¥ g%
g. Page Downkey h.  Numberkeys
i.  Alphabetkeys j- Arrowkeys
Write 'True' or 'False' :
a. True b. True c.False d. True e. False.

Match the following keys with their functions :

. PageUp . allows youtomove apageupside

. Backspace . ecrasestheletter before the cursor

. CapsLock . allowsyouto type in capital letters

. Delete . erases the letter after the cursor
Answer the following questions :

a.  Wordpad is a software which can be used to create text
documents. It is a word processing software.

The steps to start Wordpad are :

Step 1 : Click on Start button.

Step 2 : Click on Programs.

Step 3 : Click on Accessories.

Step 4 : Click on Wordpad.

The text style can be changed by using bold, italics and
underline buttons. Bold icon turns the text in dark
shade. Italics icon turns the text into italic format.
Underline icon turns the text into underlined format.

To save a document in Wordpad, the steps are :

Step 1 : Click on File option.

Step 2 : Click on 'Save' option. The Save As dialog box
opens.

b.

1Y



Step 3 : Type the name of the file in File name box.

Step 4 : Click on Save button in the Save As dialog box.
Our file is saved and the name of file shown on title bar.
We can also use 'Save' button of Standard toolbar or
'Ctrl + S' shortcut keys for saving our file.

e. When we use cut and paste command, the text moves
from one place to another. It means the text removes
from first place. While in copy and paste command, the
text is copied from one place to another. The text also

Exercise Based on NEP 2020
1. Label the icons. Use the box given below :
Ans. ox | Window Explorer
Calculator
Paint

4 e

[
Windows Media Player LJ:

L

% Wordpad

i
—_

2. Fillin the blanks :
Ans. a. The start button display all the extra programs tha are
availableasalist.
b. Window Media Player is used for playing audio,
video and viewing images on personal computers.
c. Microphone helps to record your voice on the
computer.
d. Window Explorer helps in browsing and working
with files and folders easily .
e. Calculator is an accessory that can do math
calculations speedily .
f.  Jump list takes one directly to the wedsites used every
day.

Exercise Based on NEP 2020
1. Writes the uses of the following commands :
Ans. a. RT To move turtle right
b. FD To move turtle in forward direction
c. HOME Tosend the turtle to its original position
d. CS To erase the drawing on the main screen
e. LT To move turtle left
f. BK To move turtle in backward direction
2. Give the LOGO commands for following actions :
Ans. a. FDS8O b. BK90 c. RT90
d. HOME e. CSorCLEARSCREEN
3. Tick (v') the correct option :
Ans. a.i. b.i. c. iil. d.ii. e. iil.
4. Write 'True' or 'False' :
Ans. a.True b. False c. True d. True e. False.

5. Fillin the blanks :
Ans. a. LOGO helpsyouto create shapes of your choice.
b. CS command is used to erase anything drawn in the
main screen.

remains at previous place and does not remove.
Activity & Project Tasks

Ans. Do yourself.

Windows Accessories : 'f :’f

g. To select volume control, we need to select

botton/slider .
h. Tosave ourrecorded voice, we use the sound recorded
dialog window .
3. Answer the following questions :

Ans. a. Jump List in Windows 7 taakes you right to the
documents, pictures, song or websites that you use to
each day.

b. ToopentheAccessories menu, follow these steps.
Start Menu —> All Pragrams — Accessories

c. TolaunchWindows Media Player, follow these steps .
All Programs — Windows Media Player .

d. Recordsoundusing Windows Sound Recorder.

i. Click Start— Enter Sound Recorded in Search
text box.

ii. Click on the Search result.

iii. This launches Sound recoeder.

iv. Click on the Start Recording to dtart recording .

v. Click on the Stop Recording to stop recording .

vi. Use the Save As dialog window to save the
recording .

e. Windows Explorer is an application that provides
detailed informatiom about files, folders and drives.
You can use it to see how files are organised and copy,
move and rename files as well as performed other tasks

related them.
4. Write 'True' or 'False':
Ans. a.i b.ii c.iv d.iv

Drawing In LOGO £ &>

c. LT command is used to turn the turtle in the left
direction.
d. BKisusedtomove the turtle backward.
e. FDisusedtomove the turtle forward.
6. Answer the following questions :

Ans. a. LT command tells the turtle that it has to take the left

turn.

b. RT1200rRIGHT 120

¢. BK900orBACKWARD 90

d. Runbutton should be clicked to run a command.

e. Commands to create a triangle :
FD 50
RT 90 ‘f f ’_‘> 17
FD 50
HOME

Activity & Project Tasks
Ans. Do yourself
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Ans.

Ans.

Ans.

7.
Ans.

Exercise
Tick (v') the correct option : LG
a. 1il. b. iii. C.1v. d.i. e.iv.
Werite the full forms of the following :
a. Internet International Network
b. Modem Modulator Demodulator
c. WWW World Wide Web

Rearrange the following jumbled letters to form
meaningful words :

a. TETINRNE INTERNET

b. EWRKOTN NETWORK

c. EMDIA MEDIA

d. MANIFORTNIO INFORMATION

e. IMLA-E E-MAIL

f. NWDOLDAO DOWNLOAD

g. TIEWBSE WEBSITE

h. RWRBOSE BROWSER

Name the following :

ol |

m ‘

Computer Telephone line Modem.

Match the following :

. Webpage . isanelectronic page of a website

. Internet . isthe network of computers across
the world

.  Webbrowser . letsyouview websites

. WWW . 1is the largest collection of
information on internet

Define the following terms :

a. Website : A website is a collection of related web pages
that provide us information.

b. Webpage : Webpage is a part of website. It contains
text, pictures, sounds, animation, hyperlink, etc.

c. WWW : World Wide Web (WWW) is the largest
collection of information in the form of websites of the
internet.

d. Web Browser : The websites open in a special software
known as web browser.

Answer the following questions :

a.  We can connect two or more computers with each other.

c.

Internet : ‘f :‘f

This connection is known as computer network.

The word Internet stands for International Network.

Internet is the largest network of computers.

To connect the computer to the Internet, we need the

following things :

. Acomputer system

. A Modem (Modulator Demodulator) or a neholic
card

. AnISP(acompany providing internet connection)

. Atelephone or cable line

. Software (web browser)

Internet is very useful for everyone. Some of its uses are

discussed below :

1. Internetisused to see the latest news.

2. Ithelpsto search information on any topic.

3. Ttisusedtodownload songs and movies.

4. TItisused to send and receive messages using the e-
mail facility.

5. It is the best medium to communicate instantly
with people sitting at far off places

To open a website, we type the address of the website in

the address bar and press Enter key.

Activity & Project Tasks
Write the names of any five Search Engines.

Ans.

Google, Yahoo, Rediff, MSN and Bing are five Search

Engines.
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The Computer : An Overview l.' - A. —
Exercise Based on NEP 2020 c. CPU

1. Tick (v') the correct option : d. Computer is a electronic machines, which works at a
Ans. a.i b. iii. c.ii. d.ii. very high speed and performs 100% accurate
2. Write the True or False : calculations.
Ans. a.True b. False c. True d.True e.False. e. The conversion of raw data into useful information is
3. Fillin the blanks : called data processing.
Ans. a. Computerisa highspeed data processing machines . f. Memory in computer is used to store the data

b. Abacus wsa the first calculating device. temporarly or permanently.

c. A calculating device made with the set of rods was  Activity & Project Tasks

called Napiers's Bones . Ans. Do yourself.

1. Answer the following questions :

a. Pascaline
b. Charles Babboge

Py By

Generations of Computer g % 3

Exercise Based on NEP 2020 + Mouse, Keyboard, Scanner, Sound and Video
1. Tick (v') the correct option : + Canunderstand human voice and expressions
Ans. a.ii. b. ii. c.ii. d.i. e. iii 7. Answer the following questions :
2. Werite the full forms of the following : Ans. a. A generation refers to the state of improvement in the
Ans. IC Integrated Circuit product development process. This term is also used in
IBM International Business Machine different advancements of new computer technology.
CPU Central Processing Unit b. The computers of first generation were big machines.
PC Personal Computer These were very expensive to operate and in addition to
Al Artificial Intelligence using a great deal of electricity, generated a lot of heat,
VLSI Very Large Scale Integrated Circuits which was often the cause of malfunctioning.
3. Unscramble the following : c. In the world of personal computers, the terms micro-
Ans. LOHTECNOGY TECHNOLOGY processor and CPU are used interchangeably. At the
IATRNSSTORS TRANSISTORS heart of all personal computers and most workstation
EMSI-ODCORSTUNC SEMI-CONDUCTORS sits a micro-processor. Micro-processor controls the
ROCRPOESSS PROCESSORS logic of almost all digital devices, from clock radios to
4. Fillin the blanks : fuel injection systems for automobiles.
Ans. a. A generation refers to the state of improvement in the d. Artificial Intelligence is the branch of computer science
product development process. concerned with making computers behave like
b. The first generation computers used vacuum tubes for humans.
circuitand magnetic drums for memory. e. Robotics is a technique used in computers of fifth
c. Machine language was used to perform operations, generation. Computers of this technique can see, hear
and they could not solve one problem at a time. and react to other sensory stimuli. They exhibit
d. Transistors were miniaturized and placed on silicon artificial intelligence. These computers are currently
chips, called semi-conductors. under process.
5. Match the following : Activity & Project Tasks
Ans. .  FirstGeneration . 1942-55 Ans. Do yourself.
. Second Generation . 1955-1965
.  Third Generation . 1965-1971
. Fourth Generation « 1971 toPresent
Fifth Generation Present and beyond
6. erte the input gadget used by computers during the
given generations of computers :
Ans. -+ Punched Card

* Punched Card, Magnetic tape
*+ Keyboard
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Ans.

Ans.

Exercise Based on NEP 2020

Tick (v') the correct option :

. a.iii.

b.iv. c.i.

Write 'T"' for true and 'F' for false statements :

. a.True b.False c.False d.True e.True f. False.

Fillin the blanks :

a. Acomputer is an electronic machine.

b. The data and instructions are fed into the computer
system through input devices.

c. A bit is the smallest unit of information which a
computer can process.

d. 1024 Kilobytes (KBs) make a Megabyte (MB).

e. RAMstands forthe Random Access Memory.

Answer the following questions :

a. Inacomputer memory, data is stored in the form of 'bits'
and 'bytes'. Bit means Binary digits, i.e. 0 and 1. A bitis
the smallest unit of information which a computer can
process. Byte is the combination of § bits.

b. Hard disk : 'Hard disk is the main storage medium for

computers. It is fixed inside the CPU box and contains
all the software and data.

Exercise Based on NEP 2020

Tick (v') the correct option :

a.iv. b.ii. c.il. d.iii.
Fillin the blanks :
a. Microsoft Office Word is a Word processor designed

by Microsoft.

b. Title bar tells you the name of the document.

c. Until you save the document and gave it a name, MS
Word names it document.

d. The Formatting bar displays the most common
choices for formatting text.

e. Theruler shows margins and tab stops.

f. Making changes in adocument is called editing.

Define:

a. Button bar : The Button bar offers us the most popular
menu choices. If we want anything beyond the basics,
we have to use the Menu bar.

b. TheRibbon : The Ribbon contains two parts : Tabs and
Groups. Each tab contains commands arranged in
different groups.

c¢. The Menu bar : The Menu bar contains every option
available in MS Word.

d. The Insertion point : The blinking vertical line is
called the Insertion point (or cursor) and shows where
text will start when we begin to type.

e. The Thumb bars : Thumb bars change our orientation
on the page. To use them, we place our cursor on one,
click and drag them up or down.

f. Drawing tools bar : Drawing tool bar is used to insert

shapes, lines, and Wordart into the document. Any
traditional toolbar we have asked MS Word to display
will be shown here.

Ans.

Orientation To the MS Word Screen :

4.
Ans.

Computer Memory and Storage Devices

C.

External memory is used to store the information for a
longer period. It is needed because the internal storage
of computer is insufficient to store a large amount of
data. The hard disk, compact disc, DVD, pen drive and
other storage devices of a computer form its external
memory.
Storage devices are used to store data and information
for a long time. These are permanent or non-volatile
storage devices. Secondary storage devices are mainly
external. These include :
« CD e DVD
* Pendrive e Harddisk

Activity & Project Tasks

Do yourself.

h.

View buttons : View buttons show us what “view” we
are currently in. The first (from left to right) is Normal
view, the second is Online layout view, the third is
Layout view and the last is Outline view.
Title bar : The blue coloured Title bar at the top of the
screen tells us the name of the document.

Answer the following questions :

a.

We can select text using a mouse in the following

manner :

. Toselectasingle word, we double-click the word.

. To select a sentence or paragraph, we place the
mouse pointer before the first letter and drag the
mouse by holding down the left mouse button over
the required text.

To copy and paste the text, we can follow the given

steps :

Step-1: Select the text we want to copy.

Step-2 : Click the Home tab.

Step-3 : Click 'Copy' from the Clipboard group.

Step-4 : Move the cursor to the place where we want to

paste our text.

Step-5 : Click Paste from the Clipboard group.

Moving means to shift the text from one place to

another. Moving is done by Cut and Paste commands.

To cut and paste the text, we can follow the given steps :

Step-1: Select the text we want to move.

Step-2 : Click the Home tab.

Step-3 : Click 'Cut' from Clipboard group.

Step-4 : Move the cursor to the place where we want to

paste the text.

Step-5 : Click 'Paste' from Clipboard group.

Making changes in a document is called editing. To

: ' Grow With Computer—4 '-'
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Ans.

Bullets

'

perform editing, we select the text first.

e. Ms Word is a popular word-processing program used
primarily for creating documents such as letters,
brochures, learning activities, test quizzes and students,
homework, assignment.

Activity & Project Tasks

Do yourself.

Exercise Based on NEP 2020
Tick (v') the correct option :
a. ii. b. ii. c.iii.  d.iil. el f.i g. 1il.

Label the given font group and paragraph, group
options in the Home tab :

Numbering Text Highlighl Colour

== loq Calibri (Body) gl | &1

-\‘; /zu abs 0, ¥ Aa-||®- A -
A11811 text justify \ /

Align text right Bold Ttalic Font colour

Align text center Underline

Align text left

3.
Ans.

Ans.

Ans.

Fillin the blanks :
a. Fontisthelook and shape of the letters of text.

b. Highlighting the text means placing a coloured
rectangle over it.

c. Undoisusedto cancel acommand given earlier.

d. Redocommand is used to reverse the action of Undo.
e. Atableismadeup of rows and columns.

Write shortcut keys for the following :

a. Cut Ctrl+X b. Copy Ctrl+C
c. Paste Ctrl+V d. Bold Ctrl+B
e. Italic Ctrl+I f.  Underline Ctrl+U
g. Undo Ctrl+Z h. Selectall Ctrl+A

Write 'T' True or ;'F' for false
a. True b.False c¢.True d.False e.True
Answer the following questions :

a. Formatting means changing and arranging text in a
document to make it attractive.

b. Wavyred underline indicates possible spelling errors in
adocument.

c. Highlighting the text means placing a coloured
rectangle overit.

d. Tomake the text bold, we can follow the given steps :
1. Selectthe text we want to make bold.
2. Click the Home tab.
3. Click'B'option from the Clipboard group. The text
becomes bold.

Insert tables : To insert a table in MS Word, we

: ' Grow With Computer—4 '-'

Ans.

ii.

Formatting in MS Word : ‘f.‘- w

can follow the given steps :
Step-1 : Click the Insert tab.
Step-2 : Click the Table button from the Tables
group.
Step-3 : Select the number of columns and rows by
dragging the mouse over the small boxes.
Create list with numbers : To create numbered
lists, we can follow the given steps :
Step-1 : Type the items we want to add numbers to
and select them.
Step-2 : Click the Home tab.
Step-3 : Click the drop down list arrow on
Numbering button in the Paragraph group.
Step-4 : Select the list style of our choice. The list
is numbered.

Activity & Project Tasks

Do yourself.



Ans.

Ans.

Ans.

6.
Ans.
7.
Ans.

Exercise
Tick (v') the correct option :
a.l b.i. c.ii. d.iii. e. iil.
Write the command groups for these tabs :

Based on NEP 2020

Home : Clipboard, Slides, Font, Paragraph,
Drawing and Editing
Insert . Tables, Illustrations, Links, Text and
Media Clips
Design : Page Setup, Themes and Background
Animations : Preview, Animations, Transition to the
slide
Slide Show : StartSlide Show, Set up, Monitors
Review . Proofing, Comments, Protect
View . Presentation views, Show/Hide, Zoom,
Window Macros
Circle the correct word :
a. Using PowerPoint, beautiful (workshee
can be created.
b. The Title bar is located at the (fop/bottom) of the
PowerPoint window.

c.  You can use (the Status bar/the Ruler) to determine

where you want to place an object.
d. Press(F7(F5) torunyour program as slide show.
Unscramble the following :

a. NMTONIAI ANIMATION

b. LDSEIS SLIDES

c. OERWONTIP POWERPOINT
d. OMLARNIWEV NORMALVIEW
e. IBNOBR RIBBON

h. RNIINOTSAT TRANSITION

i. AJIATNOTGVN NAVIGATION

j- SIEDLHWOS SLIDE SHOW
Fillin the blanks :

a. Microsoft PowerPoint is a presentation software.
b. The Title bar is located at the top of the PowerPoint

window.

c. The Ribbon is the panel at the top portion of the
PowerPoint window.

d. The Status bar generally appears at the bottom of the
window.

e. Normal view splits your screen into three major
sections-the Outline and Slides tabs, the Slide pane and
the Notes pane.

f.  Use the Slide Show view when you want to view all
your slides at once.

Write 'T' for true and 'F' for false statements :

a. True b. True c.False d. True.

Answer the following questions :

a. 'Microsoft PowerPoint'is a presentation software. Itisa
part of the Microsoft Office Suite of applications.

b. A presentation is made up of several electronic pages

Introduction to PowerPoint { v .‘ -

called slides.

c. Slide Showis atype of view in PowerPoint used to view

the slides, as they will look in the final presentation. We
can start slide show view by using slide show option or
button. We can also start Slide Show by pressing F5
function key.
This view is important for the users because it helps
users to see the work applied on slides and correcting
the mistake. We can, also make any changing after
previewing our presentation.

d. To create a new blank presentation, we can follow the
steps given below :

1. Click the Microsoft Office button

2. Clickon New

3. Click on Blank Presentation

4. Click on Create.

A new blank presentation with a blank slide of title
layout appears.

e. To apply a Theme on all slides in the presentation, we
can follow the steps given below :

1. Choose the Design tab.
2. Cilck the More button in the Themes group.
3. Clickthe design we want.

Activity & Project Tasks

Ans.

See the PowerPoint window given below and complete
the boxes:

1. HOME TAB
2. QUICK ACCESS TOOLBAR
3. RIBBON
4. MAXIMIZE BUTTON
5. SLIDE PANE
6. NOTES PANE
7. VIEWS BUTTONS
8. ZOOM SLIDER
A Closer Look at the Ribbon
9. TABS
10. GROUPS

11. COMMANDS
Questions About the Ribbon

12. FONT GROUP
13. SLIDE GROUP
14. INSERT TAB
15. ANIMATIONS TAB
16. REVIEW TAB
17. DESIGN TAB
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Ans.

Ans.

Ans.

. EXE.I'CIJ'E Based on NEP 2020
Tick (v') the correct option :
a. ii. b.i. c.1. d.i.

Name the following :

Speakers Computergame  Microphone Headphone.
Unscramble the following :

EMUMLTIDIA MULTIMEDIA

RPISCHAG GRAPHICS

DETSNGIIRVA ADVERTISING
OCMIROPHNE MICROPHONE

ESPAEKSR SPEAKERS

Fillin the blanks :

a. Multimedia is an application that is a combination of
text, sound, video, animation and graphics.

b. Elements of multimedia include text, graphics,
animation, audio and video.

c. Inthe area of advertisement, multimedia plays a great
role as it is the thing which is taking forward the
advertising industry.

d. For entertainment, you can use Win Amp, Real player,
Power DVD.

e. A multimedia system essentially consists of the CD-
ROM drive, sound card, speakers and monitor.

Write 'T' for true and 'F' for false statements :

a. True b. False c. True d. True
e. True f. True.
Define the following :

a. Multimedia : Multimedia is an application that is a
combination of text, sound, video, animations and
graphics.

b. Text : Text consists of characters that are used to create
words, sentences and paragraphs.

c. Animation : Animation are graphics that create
illusion of movement.

d. Computer games : Computer games are commonly
available on CD-ROMs. We can download game from
the Internet or load them from Game CDs onto our
computer. To play games, we have a joystick connected
to our computer.

e. Advertisement by multimedia : In the field of
advertising, multimedia plays a great and vital role.
Whatever it may be, whether print or electronic
advertisement, these first are prepared on the
computers by using professional softwares and then it
is brought in front of the ultimate audiences as

multimedia products.
Match the following :
. Multimedia . combination of text, sounds,
video animations, etc.
. Graphics . representation of non-textual
information
. Animation . illusion of movement

Ans.

Ans.

Ans.

Multimediag ™ & ™

. Educational software . used forlearning in schools

. Computer games . CD-ROMs

Differentiate between the following :

a. Graphics and Animation : Graphics are digital
representations of non-textual information such as
drawing chart or photograph while animation are
graphics that create illusion of movement.

b. Audio and Video : Audio is any digitized music speech
or other sound. Video consists of photographic images
that are played back at the speeds of 15 to 30 frames per
second and provide appearance of real-time.

c. Educational software and Video games : Educational
software are used for learning purpose. The topics are
effectively demonstrated with the help of educational
software. While video games are the software which
we use for entertainment purpose. Computer games are
very popular among children.

d. Headphones and Microphone : A headphone is
output device used for listening the audio output while
amicrophone is an input device used to give voice input
to the computer.

e. Textand Graphics : Text consists of characters that are
used to create words, sentences and paragraphs. While
graphics is digital representations of non-textual
information such as drawing chart or photograph.

f. Microphone and Speakers : A microphone is an input
device used to give voice input to the computer. While
speakers are output device used for listening the audio
output.

Answer the following questions :

a. Multimedia is an application that is a combination of
text, sound, video, animations and graphics.

b. A Multimedia System essentially consists of the
following hardware :

1.  ACD-ROMdrive for playing CD.

2. ASound card and Speakers for producing sound.

3. Colour monitor to display video.

4. Microphone and headphones for recording and
listening to sound.

c. Themultimedia is commonly used :

1. Foreducational purposes.

2. Foradvertising.

3. Forentertainment.

4. Forcreating computer games.

d. Text, graphics, animation, audio and video are the
elements of multimedia.

Activity & Project Tasks

Do yourself.
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Ans.

Exercise Based on NEP 2020
Fillin the blanks :
a. Pictures are saved as thumbnails in the virtual book of
Tux paint.
b. The play button is used to start the slide show.
¢. TuxPainthas different canvases also .
d. Some Stamp can be flipped vertically .
e. Printbutton is used to print the open picture.
Write the 'T' for true and 'F' for False Statement :
a. False b. True. c.False d.True e.False
Match the following :
a. i. Opentheselected type
b. [ ii. Stamps

iii. Opensanew Drawing Canvas

d. 2 »1v. Creates mirror images of stamp

Answer the following questions :

a. Follow these steps to print a picture :

i.  Click onthe Print tool in the Toolbar pane.

ii. A dialog box appears asking for your permission to
print the opened picture. Click on yes, print it! option.

iii. The Print dialog bax appears. Selected the printer
connected to your computer in the select Printer section
and specify your printing preferences.

iv. Click on the Print button.
Follow these steps to watch a slide show of the pictures
created.

i.  Selectthe Opentool in the Toolbar pane.

ii. A list of pictures created and saved in Tux Paint,
appears as thumbnails in the virtual Picturebook.

iii. Click on the Slides button in the lower-left corner of the
virtual Picturebook.

Fun with Tux Paint f 'f.' ’f

iv. A new pane appears in the middle of the window
containing pictures saved in Tux Paint. Click on the
images in the sequence in which you want them to
appears in the slide show . The images will be
numbered accordingly.

v. Set the speed of slide change using the sliding scale
next to the Play button.

vi. Click on play button to start the slide show .

vii. Slides changes automatically after the selected time
frame or you can also click on the Next button to move
the next slide.

viii. Click on the Back button to go back to the thumbnails.

c. An outline image of the stamp is seen when the mouse
is bought over the Drawing Canvas telling the user
aboutits size and location .
Multiple copies of the same stamp or of different
stamps can beplaced at different locations in the
Drawing Canvas.
Different categories of stamps are available for use in
the selector pane of the Tux Paint window.
There are additional options in the Stamp tool which
allow the user to flip the selected stamp vertically or
create its mirror images.
Paintbrush, polygon, line, eraser etc.

e Selectprinter and print button .

Activity & Project Tasks

Do Your Self
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1.

Ans.

2.

Ans.

Ans.

Ans.

Ans.

Ans.

Ans.

Ans.

Exercise Based on NEP 2020
. . ased on
Tick (v') the correct option :
a.i. b.ii. c. iil. d.iii. e.iv.

Name these web browsers :

Google Chrome
Name these search engines: _

Google.com Ask.com Yahoo.com

Name these Internet explorer buttons :
@ Back button
» Forward button

s Favourite button
& History button
Fillin the blanks :

a. Internetisthe abbreviation of International Network.
. WWW stands for World Wide Web.

c. Internet provides a facility called chatting with which
people can communicate with each other from
anywhere in the world.

d. Using the e-mail facility, messages can be sent or
received from anyone connected through the Internet.

e. Websiteisa collection of related webpages.

f.  Home page is the main page of a website.

Write 'T' for true and 'F' for false statements :

a.False b. True c. True d. True

e. True f. False

Match the following :

. WWW . isthecollection of websites

. Homepage . isthe mainpagefora
particular website

. Webbrowser . allows youtoaccess internet

. Google, Yahoo . arepopular search engines

. G-Mail . provides you e-mail service

Define the following :

a. Internet: Internetstands for International Network. It
is awell organised and managed network of millions of
computers connected all over the world to share and
exchange information.

b. Home page : A Home page is the main (index) page for

Ans.

Networking and Internet !.' "f.‘- v

a particular website. When we open a website, this is
the page that we get.

c.  Web browser : A Web browser is a software thatis used
to access information on the Internet. Some popular
web browsers are Internet Explorer, Mozilla, Firefox,
Opera, Google Chrome, etc.

d. Search engine : Search engine is a website that helps us
to find information and address of websites on Internet.

e. Online shopping : By using the Internet, different
things can be purchased that are delivered at the door
step of the person who has ordered for them.

Answer the following questions :

a. Internet Explorer and Mozilla Firefox

b. A Website is a collection of webpages containing
information that is related.

c. A Home page is the main (index) page for a particular
website. When we open a website, this is the page that
we get.

d. Thetwo applications of Internet are :

1. Searching/Finding Information : Internet Search
sites can search enormous databases of webpages,
using titles, keywords or text.

2. Communication : To communicate instantly with
the people sitting at far off places, Internet provides a
facility called chatting. With this, people can
communicate with each other using text as the medium
atany time and anywhere in the world.

Flipkart and Snapdeal

Achwf y & Pro ject Tasks

Ans.

Write a short article on the advantages and
disadvantages of Internet.

A short article on the advantages and disadvantages of
Internet : The internet is a very useful tool at present. It
helps in the universalization of knowledge and other
resources. It is a platform to connect the people in the world.
It is the largest network. It provides us facilities like
searching information, communication by chatting, e-mail,
advertising about products, online shopping, listening to
songs and watching movies, reservation, banking and
others. But it has some disadvantages also. As it is becoming
popular the internet providing companies are charging hand
some amount for accessing Internet. Fake websites are
increasing on intenet day by day. Such fake websites
mislead the users. Viruses are being spread through e-mails.
Hackers and crackers steal the password and other
confidential information through the Internet.

So, we can say that Internet is useful as well as harmful for
the society. We must use internet by having some
appropriate security.

Search the function of there buttons using search engine
on any web browsers :

To reach home page of a website.
|i] To refresh or reload the web page.

= To search any topic, term or information on a
'3 particular website.

: ‘II Grow With Computer—4 '-'II



Ans.

Ans.

Ans.

Ans.

Ans.

Grow With Computer-5

Exercise Based on NEP 2020
Tick (v') the correct option :
L. 1ii. b. iii. C.i. d.ii.
Fillin the blanks:

(a) Ports are the inlets present in the CPU box that lets you
plug various devices to a computer system.
(b) A motherboard holds the cards such as sound cards and

video cards.

(c) A joystick is an input device which is used mostly for
playing games.

Find the odd term out:

a. Printer b. Microphone

c. RAM d. Barcode reader

Answer the following questions:

a. A graphic tablet is an input device. It isused to draw
image and pictures on the computer screen in a similar
way as you draw pictures with a pencil on paper.

b. Impact Printers and non-Impact printers.

¢.  Amotherboard is the main board that holds many of the

Exercise Based on NEP 2020
Tick (v') the correct option :
a.ii. b. iii. c.i. d.i. e.iv.
Complete the following words :
a. BOOTING b. BINARY
c. BITS d. MACHINE
e. ASSEMBLER f.  MNEMONICS
g. TRANSLATOR h. VIRUS
I. SOFTWARE j.  PROGRAM
k. LANGUAGE
Write 'T' for true and 'F'for false statements :
a.False b. True c.False d. True e.False
Fillin the blanks :

a. Language is the medium to communicative with others.

b. Acomputerunderstands binary language.

c. Assembly language uses mnemonics.

d. Virus is a program that destroys the software and
programs.

e. 1024 MBs form 1 Gigabyte (GB).

Answer the following questions :

a. Langauge means medium through which we .
communicate with each other.

b. Binarylanguage

c. Machine language, Assembly language and High level
language

d. Bits is a group of two digits 0 and 1. Bits is the short
form of binary digits. A language consists of binary
digits is called binary language.

Ans.

Ans.

Computer Overview l.' ” A. -~

cruicla components of a computer system. It allows all
the parts ot receive power and communicate with one
another. The motherboard holds the processor, memory
chips, and several cards such as sound card, video card
and modem.

d. A touch screen is a touch-sensitive computer display
screen that can also act as an input device.It can identify
the presence and position of a touch inside the display
region.

e. Various hardware components such as motherboard,
processor or CPU, memory chips, RAM and ROM,
hard-disk drive and SMPS are present inside the CPU
box.

ACTIVITYAND PROJECT TASKS

Do yourself.

Computer Languages g ™ & ™

While Byte is a group of 8 bits. Also, 1024 bytes form 1
Kilobyte (KB).

e. In Assembly language, the instructions are written in
mnemonics. A mnemonic is a short name given to an
operation. For example, SUM is for addition, SU is for
subtraction, etc.

f. Machine Language : It is the language which

computer can understand directly. This language is
coded in binary language which is the combination of
Osand Is.
Assembly Language : This language was introduced
to decrease the burden of remembering the
combination of Os and 1s. In assembly language, the
instructions are written in mnemonics. A mnemonic is a
short name given to an operation.

g. BASIC,FORTRAN, C, C++, Java,net, etc.

h. Aprogramis aset of instructions given to a computer in
acomputer language.

System software and Application software.

Achwfy & Project Tasks

Write the names of some computer languages.
Binary language, Assembly language, BASIC, FORTRAN,
COBOL, C, C++, Java. net, etc.
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Ans.

Exercise Based on NEP 2020

Tick (v') the correct option :

a.ii. b. ii. c.iv. d.i.

Fillin the blanks:

a.  Word processing software are the most suitable type
of software for typing assignments.

b. Spreadsheets are the most suited for calculating and
preparing charts.

c. Graphics Software are the most suited for creating
designs and layouts of books.

d. Presentation Software are the most suitable type of

software for preparing slides to show to an audience on
aprojector.

Answer the following questions:

a.

%

System Software: The system software is required to
control the overall operations of a computer system. It
can be classified into three categories- Operating
System, Language Processors and Utility Software.
Application Software: Application software is a set of
programs designed to help users perform specific tasks.
They may be installed on a computer depending upon
the user requirements. Different application software
are available to serve different purposes.The
application software can furthe be divided into two
categories- General Purpose, Application Software and
Specific purpose Application Software.

Operating System: An operating system (OS) is the
most important software without which you cannot
work on a computer system. It is the most basic
software that is present in a computer. It serves as an
interface between the user and the hardware. Som eof
the basic functions the an operating system performs
are:

It provides an environment in which computer
hardware componenets are used in an efficient manner.
It acts as a resource manager. A computer system has

Computer Soft And Its Types : v :‘f

many resources such as CPU time, memory space and
/O devices.

General purpose application software are developed
keeping in mind the general needs and requirements of
alarge number of people.

Antivirus Software: A virus is a computer program
that may disrupt the normal functioning of your
computer. It can slow down the working of a computer
or may sometimes even lead to the system crash. In
order to remove such dengerous programs antivirus
program need to be used. An antivirus progrm scans you
disc and viruses, and removes them. Few examples of
antivirus software are - Norton, AVG, Avira and
McAfee.

Language Processor: Software ae created by writing
programs in computer lanagues.There are many
computer languages such as C, C++ and Java.The
understood by a computer. A computer is an elelctronic
machine, and can only understand the machine
language which comprises 'zeros' and 'ones'.

A language processor is a very important software as it
translate or convert or program written in a computer
language into the machine language form so that it can
beunderstood by a computer.

ACTIVITY & PROJECT TASKS

Ans.

Do yourself.
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Exercise Based on NEP 2020
Tick (v') the correct option :
a. i b.iv. c.iil. d.i. e.iv.
Fillin the blanks :
a. Networking is the solution to limited resources and
costreduction.

b. LAN, MAN and WAN are three types of network.
c. TheInternetisanetwork of networks.
d. Theinternetservice is provided by ISPs.

Match the following :

. Workstation . Acomputerinanetwork

. LAN . Local Area Network

. Modem . Modualator-demodulator

. WWW . World Wide Web

. Server . Maincomputer in a network

Answer the following questions :

a. The word 'network’ may be defined as a collection of
computers connected together for the purpose of
sharing information and resources.

b. The need of networking arises due to the following
reasons:

1. Limited resources : Instead of connecting a printer
to all the computers separately, we can connect it to the
main network. In this way, every computer can share
the printer on a priority basis.

2. Desire to share information : Information is
centralised. Thus, it is made available to all the
computers connected to a network.

3. Cost reduction : It reduces cost as input device like
scanner and the output device like printer can be easily
shared.

c. In a network, we can share information as well as
resources. In case of a school network, we can give a
print command from ten different computers to one
printer when these computers are connected to each
other and with main computer (server). A printer or any
other resource is mainly connected to the server and

Ans.

Exercise Based on NEP 2020
Tick (v') the correct option : 4.
a. i b. iii. c.il. d.i. e.l. Ans.
Give the use of the following tools of web browsers :
This tool is used to reach the first page of the website. 5.
Itisused to reach the previous page. Ans.
It takes us to the next page.
It stops the loading process of the webpage from Internet.
It restarts the loading process.
It saves/stores the previously viewed sites for a
particular period.
Correct the following statements :
a.  Web browser is a software which unable the users to
access Internet.
Webpages are written in HTML language.
The Menu bar has different menu options.
The Restart button restarts the loading process.
Favourite button stores address of a few interesting
sites.

moe o o
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Networking : - f’f

other computers are also connected to the server. All
other computers (Nodes) connected to the main
computers (server) can share peripherals in a network.

d. Modem : Itis amodulator and demodulator. It converts
the digital signals to analog and vice versa for effective
transmission of data.

e. 1.Email : Email is the abbreviation of Electronic mail.
It allows computer users locally and globally to
exchange messages. The users have a mailbox address.
For example, abc@ gmail.com. The messages sent
through email can arrive within a few seconds.

2. E-business : Internet is a good platform for business.
New products can be launched, imagined and
advertised. Customers can buy and sell products
through the Internet. Selling and purchasing through
internet is called online shopping.

3. Entertainment : The Internet is also a good source
of entertainment. We can download music files, video
files, games, etc. Some games are available online also.
We can access information on any subject and get to
know what is going on around the world.

Activity & Project Tasks

Prepare alist of any ten educational websites.
www. time4learning.com
www.educents.com
www.khanacedamy.org
www.lessonpathways.com
www.educationcreations.net
www.enchantedlearning.com
www.mobymax.com

www. brainpop.com
WWW.pppst.com
http://powermylearning.org

CPOX_NANN B WD =
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Searching on Internet : - f’f

Write 'T' for true and 'F' for false statement :
a.False b. True c. True d. True e.False
Answer the following questions :

a. Web browsers are the software which unable the user to
connect with a website and the webpage

b. Internet Explorer and Google chrome.

c. Title bar shows the name of working website loaded in
the particular window.

d. Hyperlinks are used to surf the webpages. Before
hyperlink, it was impossible to reach from one page to
another directly like page 1 to page 10.

These are highlighted text/image when selected display
the information on the particular topic.

e. Thespecial features shown by the hyperlink are :

(1) Underlined
(2) Givenwithdifferent colours
(3) Whenwe move apointer over it, its shape changes

P




from arrow to hand shaped pointer showing
hyperlink.

f.  Search engine is a website that helps us to search the
information from the Internet. There are various search
engines available on Internet, few are listed below :
Google.co.in Yahoo.com Lycos
MSN Altavista.com

g. Thesteps to search information are as follows :

1. On the address bar of web browser, type the URL
of'search engine.

2. Once the search engine screen appear, type the
search terms.

3. Clickonsearchbox.

Search engine does not show the information of about

the search terms directly instead displays the list of

different website links. Clicking on them we can easily

access the specified information.

Activity & Project Tasks

Ans.

1.
Ans.
2.

Ans.

Ans.

Ans.

Ans.

List different address of some search engines.

1. www.google.co.in 2. www.yahoo.com
3. www.lycos.com 4. www.msn.com
5. www.altavista.com 6. www.rediff.com
7. www.bing.com 8. www.ask.com

9. www.hotmail.com 10. www.wow.com

Exercise Based on NEP 2020 Ans. a.
Tick (v') the correct answer :
a. ii. b. ii. c.ii. d.ii. e. ii.
What does the following icons stand for : b.
J New file
: Open existing file
c.
H Save file
0 Printfil
rint file d
Ja Cuttext
Copy text
¥ Format Paintericon
Write 'T' for true 'F' for false statements :
a.False  b.True c. True d. True e. False
Fillin the blanks :
a. [Editing means making a change in a document or text.
b. MS Wordis also known as Word processing software.
¢.  Youcaninsertablank line between two existing lines.
d. Undocommand is used to reverse the last command.
e. Redocommandisusedtoreverse the undo action.
Give the function of the following keyboard shortcuts :
a. Cul+N To open a new window e
b. Ctrl+X To cut text
c. Ctrl+V To paste text
d. Ctl+C To copy text
e. Cul+Y Toredo
f. Cul+Z To undo
g. Alt+F4 To close the document
h. Cul+0O To open an existing file
i Ctul+S To save a document

Answer the following questions :

MS Word £% &

A change made in a document is called editing. When
we want to make any change, we have to select text
before editing it.

The copy command creates the duplicate of the selected

text, leaving the original text unchanged. While the Cut

command deletes the selected text from its original
position.

The steps to delete a block of text are :

. Selectthe text to be deleted.

. Pressthe Delete key or the Backspace key.

We can move text from one position to the other using

the Cut and Paste command. The Cut command deletes

the selected text from its original position and the Paste
command places this text at the position where the
cursor is placed.

Steps to move the text are :

«  Selectthe text to be moved.

«  Select the Cut option from the Edit menu or Right
click the mouse button and choose the Cut
command.

«  Place the cursor at the position where the text to be
placed.

+ Select the Paste option from the Edit menu or Right
click the mouse button and choose the Paste
command.

Copying the text means creating the duplicate of the

selected text, leaving the original text unchanged. The

steps to copy textare :

. Weselectthe text to be copied.

. We select the Copy option from the Edit menu or
press Ctrl+C.

. Now, we position the cursor at the location where
we want to paste the text.

. Weselectthe Paste option from the Edit menu.

The text appears at the place where the cursor is
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Ans.

Ans.

positioned.
f. To insert a blank line between two existing line, the
steps are :
. We place the cursor at the end of the line after
which we want to insert a line.
. Now, we press the Enter key. We can see that the
line gets shifted down and a blank line is inserted.
Undo command is used to reverse the last command.
The steps to delete a block of text are :

L '/

Exercise Based on NEP 2020
Tick (v') the correct option :
a.i. b.1ii. c.iv. d. iii.
Fillin the blanks :
a. A table is used to create data in the form of rows and
columns.
b. Insert Table icon present on the standard toolbar helps
to create table.

¢.  When you click on Draw Table option, the mouse
pointer changes to a pencil which can be used to draw
tables in a document.
. Eachrectangularbox in a tableis called a cell.
e. Acolumncanbe deleted by using Delete option from

the Table menu.

Match the following :

E Merge cells j
Split cells

E&: Formula T

— nsertabove -
Insert Right

=== Delete f X

Write the steps to perform the following questions :
a.  We can add additional rows to the table at the end by
following the given steps :
1. Movetothelastcell of last row of the table.
2. Pressthe Tabkey.
3. Typethetextshown here.
b. Todelete any column, we do the following steps :
1. We place the cursor anywhere in the column to be
deleted.

2. Now, we select Table menu —>Delete option —
Columns option.
c. Using Microsoft Word,we can merge cells i.e. we can
combine two or more cells into one cell. The steps are :
1. We select the cells (two or more) we want to
merge.
2. Weclickin Table menu — Merge Cells option.
d. To apply an Auto Format to the table, we do the
following steps :
1. Weclickanywhere on the table.
2. Click on Table menu —Table Auto Format option.
3. ATable Auto Format dialog box appears. Now, we
click on Table colourful 1 option in the Table styles
list.
4. Select Heading Rows and First Column in the
Applying special formats to frame.

Ans.

5.

Ans.

1.

. Selectthetextto be deleted.
. Pressthe Delete key or the Backspace key.
Tocut—Ctrl + X
To paste—Ctrl +V
Activity & Project Tasks

Do yourself.

Creating Tables in MS Word £ ";.' ¥

5. Now, weclickon Apply.

Answer the following questions :

a.

Inserting table using Table menu :

1. Weclick on Table menu — Insert — Table option.

2. The Insert Table dialog box opens. Now, we can
type the number of columns and rows to get the
desired table size.

3. We select Auto in the Column width drop down
list, selecting Auto option allows Microsoft Word
to determine the size of the column widths, other
wise we can enter the desired column width.

4. Atlast,weclick on OK.

Yes, we can add a new row in the middle of an ex1st1ng

table To add a new row in the middle of an exising

table, we can do the following steps :

1. We place the cursor anywhere in the row below
which we want to insert a row.

OR
Place the cursor anywhere in the row above which
we want to insert a row.

2. Click on Table menu — Insert — Rows Above
option in case of inserting arow above the existing
row.

OR

3. Click on Table menu — Insert — Rows Below
option in case of inserting a row below the existing
TOW.

We can use Auto Format feature to apply boarders,

shading, special fonts and color to the table. Microsoft

Word lists all formats in the Table Auto Format dialog

box. In the Table Auto Format dialog box, we may click

on a format to see that format displayed in the preview
box.

We can customise how the format is applied. Microsoft

Word comes with along list of Auto Format.

To apply an Auto Format to the table, we can do the

following steps :

1. Weclick anywhere on the table.

2. Click on Table menu — Table Auto Format option.

3. ATable Auto Format dialog box appears. Now, we
click on Table colourful 1 option in the Table styles
list.

4. Select Heading Rows and First Column in the
Applying special formats to frame.

5. Now, weclickon Apply.

The intersection of a row and a column makes a

rectangular box called a cell.

We can draw a table with any number of rows and

columns using Draw Table option of Table menu.

When we click on Draw Table option, the mouse

: ‘II Grow With Computer—Sm '-'II



Ans.

Ans.

Ans.

Ans.

Ans.

pointer changes to a pencil.

To draw a table with four rows and two columns, we can

do the following steps :

1. Click Draw Table option of Table menu.

2. By holding the left mouse button pressed, move
the mouse from one place to another horizontally.
Doing this arow is drawn.

3. Todraw four rows, we do the same activity for four

times.

Now, we can draw a line vertically from the middle

Exercise Based on NEP 2020
Tick (v') the correct option :
a. iii. b.iii. c.i. d. iii. e.i.

Correct the following statements :
a. MS PowerPoint presents information in the form of
slides.

b. Note's pane displays the notes in presentation.

c. Toinsertanewslide, press Ctrl+ M.

d. Tosaveafile, press Ctrl+S.

e. Theextension of PowerPoint file is .ppt.

Fillin the blanks :

a. Microsoft PowerPoint is a presentation software.

b. Blank presentation provides you totally blank page.

c. Status bar is placed at the bottom of PowerPoint
screen.

d. Toinsertanew presentation press Ctrl+N.

e. Youcanalso print copies of your slides.
Write 'T' for true and 'F' for false statements :

a. True b.False c. True d. False e. True
Match the following :

. PageUp . Nextslide

. PageDown . Previousslide

. Ctrl+Home . Beginning of the presentation
. Ctrl+End . Endofthepresentation

. F5 . Start Slide Show

. Cul+M . Addnewslide

Answer the following questions :

a. Microsoft PowerPoint is a presentation software. It
presents information in the form of slides.

b. Menubaris placed just below the Title bar. It consists of
a list of menus. On clicking a menu bar item, a list of
commands drop down.

Exercise

Tick (v') the correct option :

a.ii. b.i. c.il. d.ii. e.1.

Correct the following statements :

a. Input/Output box is used to suggest the input of the
data or output of the information.

b. Flowchart should be either top to bottom or left to
right.

c. Decision box is used when some comparison has to be
made.

d. Thesymbolsin flowchart are very easy to understand.

e. Withthe help of a flowchart, problems can be analysed.

Write the algorithms next to the flowchart :

Based on NEP 2020

ofthe table to get two columns.
The table appears on the screen, will be of four rows and
two columns.

Activity & Project Tasks
Do yourself.

Ans.

Ans.

Ans.

Ans.

By By
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The steps to create a slide are :
Step 1 : Click Office button — New.
Step 2 : Select Blank presentation from New presentation
pane.
Step 3 : A blank slide is displayed with two place
holders.
Step 4 : To enter the text in a placeholder, click within it
and start typing.
Step 5 : When finished click outside the placeholder.
The steps to save a presentation are :
Step 1: Select File —>Save As.
Step 2 : Save As dialog box appears.
Step 3 : From Save in drop-down list, select the drive
and then select the folder.
Step 4 : In file name box, we type the file name.
Step 5 : Now, we can select the type of extension from
Save as type drop-down box.

OR
To savea file, we can press Ctrl +S.
After finishing our presentation, we can view our slides
in a sequential manner through a slide show. In a slide
show, all the slides in our presentation are displayed
sequentially full screen.
To run a slide show, we can follow these steps :
Step 1 : Select View > Slide Show > View Show.

OR
To run a slide show, we can also press F5.

Activity & Project Tasks

Do yourself.

i S
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Go to the wash hand.

Rinse hand with water.
Apply hand wash.

Are the hands clean.

Wipe your hand with a towel.
Stop.

t1n correctorder:

Gets up and has a bath.
Takes his breakfast.

Looks at his watch.

Takes his bag and lunch box.
Catches his school bus.
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Ans.

Ans.

2.
Ans.

Write 'T' for true and 'F' for false statements :

a. True

b.False  c¢.True d.False e. False.

Answer the following questions :

a.

b.

People who make programs are called programmers.

We can solve the problem by using the algorithm. The

steps to solve the problem are :

1. Write the problem in many steps.

2. Make the complete algorithm and put them in
correct order.

3. Putthealgorithm in flowchart.

4. Ifthe steps are in correct order, the right result will
be displayed.

Flowcharts are the pictorial representation of the

algorithm steps used to solve a problem. To create a

flowchart some standard symbols are used where each

symbol represents a specific type of operation.

An algorithm is a step by step representation of the

solution of a problem. These are written in simple

english language. While flowchart is a pictorial

representation of the sequence of the steps to solve a

particular problem. In a flowchart representation, some

standard symbols are used and these symbols are

connected with each other by flow lines.

The basic rules to create flowchart are :

1. Flowchart should be either top to bottom or left to
right.

2. Arrow heads must be used with flow lines showing
the flow of sequence.

3. Crossing lines should be avoided.

Exercise Based on NEP 2020

Tick (v') the correct option :

a. iii. b.iv. C.i. d.i. e.iv.

Fillin the blanks :

a. Any software designed to harm the computer, or disturb
its normal operations is known as malware.

b. A Trojan horse can allow other people to remotely
control your computer.

¢.  Youcanmake use of an antivirus software to detect the
presence of virus.

d. A virus can attach itself to files and spread when files
are transferred.

e. Aworm can spread on its over a network and reduce the

speed of the network.

Answer the following questions :

a.

i.  Acomputer virus is a kind of malware that spreads
itself from one computer to another, and interferes
with the normal operations of a computer.

ii. A worm is a kind of malware that uses computer
networks to send copies of itself to other
computers on the network.

iii. Trojan horse, or Trojan, is a kind of malware that
appears to be a useful software but will actually
cause damage once installed or executed on our
computer. After getting installed, it allows
unauthorised access to the computer.

iv. Antivirus software can be used to protect a

f.

g.

4. If flowchart is using more than one page,
connectors must be used.

The advantages of using flowchart are :

. The symbols are self-explanatory. Thus, these are
easier to understand.

. Their graphical nature make the process of
explaining an algorithm quite straight forward.

. With the help of a flowchart, problems can be
analysed in a more effective way.

The disadvantages of using flowchart are :

. Diagrammatic representation takes a lot of time.

. Itisdifficult to handle complex programs.

. Standard rules has to be followed for making a
flowchart.

. Ifchanges are required, the flowchart may require
re-drawing completely.

Activity & Project Tasks

Prepare an Algorithm to prepare a cup of tea.
Ans. Analgorithm to prepare a cup of tea :

NNk PD—

8.
Now, the te

Take an empty pan.

Pour water in it.

Putiton gas burner.

Puttea leaves into boiling water.
Addsugarinit.

Pour milk to the boiling mixture.
Boil the mixture.

Strain into the cup.

ais ready to drink.

Computer Malware : - : —4

computer from all types of malware. Antivirus
software can detect viruses, worms, etc. and warn
us of their presence in our computer.

There are several ways by which a computer may get

infected with a virus.

CDs and Pen Drives : Our computer may get infected

by copying infected files from CDs and Pen drives.

. Internet : Viruses can be attached to various types
of Internet files such as graphics and programs
files that people download from the Internet.

. E-mail Attachments : Viruses often travel
through e-mail attachments. They enter the
computer when we download or run an e-mail
attachment.

We must follow some precautions to stay secure and

protect our computer from getting infected by different

types of malware.

. Useoriginal operating system

. Useanantivirus software

. Update the antivirus software on aregular basis

. Beware of e-mail attachments from unknown
sources

. Do not download pirated software, songs, movies,
games, etc.

. Visittrustworthy sites

. Scan all e-mail attachments and files from CDs,
DVDs, etc. before running or storing from on the
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computer.

d. Antivirus software can be used to protect a computer
from all types of malware. Antivirus software can
detect viruses, worms, etc. and warn us of their
presence in our computer. It can deactivate and clean
the computer of different types of malicious software.
There are various types of antivirus software such as
Norton, McAfee, AVG and Avira.

Activity nd Project Tasks
Ans. Doyourself.
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